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ABSTRAK 

 

Metode VAR merupakan metode peramalan 
menggunakan data runtun waktu multivariat dengan melihat 
hubungan antar variabel dan menghasilkan lag optimal untuk 
membentuk model VAR. Data yang digunakan dalam 
penelitian ini adalah data curah hujan atau Stasiun Post Hujan 
(SPH) Kabupaten Kudus bulan Januari-Desember tahun 2019-
2020. Data ini untuk meramalkan nilai SPH Kabupaten Kudus 
tahun 2021. Curah hujan menjadi salah satu tolok ukur untuk 
memulai suatu kegiatan. Dalam beberapa periode terakhir, 
musim hujan dan musim kemarau mengalami pergeseran. 
Kondisi yang tidak beraturan ini mengakibatkan curah hujan 
sulit untuk diprediksi secara tepat. Maka dibutuhkan 
informasi prediksi curah hujan untuk mendukung berbagai 
kegiatan seperti pada sektor pertanian, perairan, 
perhubungan, dan lain-lain.  Variabel dalam penelitian ini 
adalah SPH Besito, SPH Cendono, SPH Colo, SPH Jekulo, SPH 
Karanggayam, SPH Kedunggupit, dan SPH Kota. Hasil 
penelitian menunjukkan bahwa data SPH Kudus tahun 2019-
2020 optimal pada lag-1 sehingga model VAR yang terbentuk 
adalah VAR(1). Artinya variabel-variabel yang digunakan 
dalam model saling berpengaruh tidak hanya pada periode 
2021, namun juga pada satu periode sebelumnya. 
 
Kata Kunci: VAR, VAR(1), Lag Optimum. 
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BAB I 

PENDAHULUAN 

A. Latar Belakang 

Curah hujan merupakan salah satu bagian dari cuaca 

dan iklim. Curah hujan dapat dihitung harian, bulanan 

maupun tahunan. Salah satu penentu musim adalah 

perhitungan curah hujan. Jika curah hujan tinggi setiap 

harinya maka dapat dikatakan sebagai musim hujan, dan jika 

sebaliknya maka dapat dikatakan sebagai musim kemarau. 

Curah hujan merupakan salah satu tolok ukur untuk memulai 

suatu pekerjaan. Salah satunya bagi para petani dan nelayan 

dalam melakukan pekerjaan. 

Indonesia memiliki dua musim yang seimbang yaitu 

musim hujan dan musim kemarau. Dalam beberapa periode 

terakhir musim hujan dan musim kemarau mengalami 

pergeseran. Seperti pada tahun 2019, musim kemarau 

bergeser pada bulan Juni sampai November, sedangkan 

musim penghujan bergeser di bulan Desember dan 

puncaknya pada bulan Januari akhir. Kondisi tersebut akan 

mengalami perubahan yang tidak teratur dalam kurun waktu 

yang acak, sehingga sulit untuk diprediksi secara tepat.  Maka 

dari itu dibutuhkan peramalan cuaca yang tepat karena 

informasi tentang cuaca sudah menjadi kebutuhan untuk 
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mendukung kegiatan pada sektor pertanian, perairan, dan 

perhubungan. 

Pada sektor pertanian digunakan dalam penentuan 

musim tanam. Sedangkan dalam sektor perairan digunakan 

untuk membantu mendeteksi bencana seperti banjir, tanah 

longsor, tsunami dan bencana lainnya. Dalam sektor 

perhubungan digunakan untuk menentukan keadaan cuaca 

terkait transportasi laut dan udara. 

Kabupaten Kudus merupakan kabupaten yang diapit 

oleh empat kabupaten, yaitu Demak, Jepara Pati, dan 

Grobogan. Kabupaten Kudus tidak memiliki daerah pesisir 

seperti halnya Kabupaten Demak, Jepara, dan Pati. Namun, 

Kabupaten Kudus memiliki daerah pegunungan yaitu daerah 

lereng gunung Muria sehingga suhu udara di Kabupaten 

Kudus lebih rendah dibandingkan dengan kabupaten-

kabupaten daerah pesisir di sekitarnya. 

Menurut data dari stasiun 164-sr-32 Kudus rata-rata 

curah hujan pada tahun 2011 sampai 2015 adalah sebesar 

2455 mm/tahun. Sedangkan untuk Kabupaten Demak yang 

merupakan perbatasan sebelah barat Kabupaten Kudus 

menurut data dari satsiun 5 Bendung Jragung tercatat rata-

rata curah hujan pada tahun 2014 sampai 2018 sebesar 

1725,52 mm/tahun. Kabupaten Pati yang merupakan 

perbatasan sebelah timur tercatat dari stasiun 178 juana rata-
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rata curah hujan pada tahun 2011 sampai tahun 2015 sebesar 

1191 mm/tahun. Sedangkan untuk Kabupaten Grobogan dari 

stasiun curah hujan 75a Dangi Klimat tercatat 1976 

mm/tahun. Dari data-data tersebut dapat disimpulkan bahwa 

Kabupaten Kudus memiliki rata-rata curah hujan 

pertahunnya lebih tinggi dibandingkan dengan kabupaten-

kabupaten yang menjadi perbatasan Kabupaten Kudus. Dalam 

hal ini artinya Kabupaten Kudus lebih banyak hari hujannya 

dibandingkan dengan daerah-daerah sekitarnya. 

Curah hujan yang tinggi dapat memberikan dampak 

positif dan negatif bagi masyarakat Kudus. Seperti halnya, 

dari sembilan kecamatan di Kabupaten Kudus terdapat empat 

kecamatan yang setiap tahunnya terjadi banjir yaitu 

kecamatan Jati, Kaliwungu, Mejobo, dan Undaan. Hal ini 

diakibatkan oleh kiriman air dari anak sungai yang berada di 

lereng Gunung Muria. Banjir di Kabupaten Kudus tidak hanya 

menggenang ke dalam rumah-rumah warga, namun juga 

memutus akses jalan pantura di Kabupaten Kudus. Kemudian 

di Kabupaten Kudus juga terdapat dua kecamatan yang sering 

terjadi bencana longsor yaitu kecamatan Gebog dan Dawe. 

Daerah tersebut merupakan daerah pada bagian lereng 

Gunung Muria. Hal ini sangat merugikan masyarakat maupun 

pemerintah Kabupaten Kudus. 
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Peneliti mengambil data curah hujan di Kabupaten 

Kudus karena curah hujan merupakan hal pokok bagi 

masyarakat dalam menentukan suatu perjalanan 

pekerjaannya. Seperti hal nya dalam proses pengiriman 

barang dari suatu daerah ke daerah lain. Curah hujan yang 

tinggi dapat menghambat jalur proses pengiriman. Menurut 

kondisi geografisnya, Kabupaten Kudus terletak pada 

persimpangan jalur transportasi utama Jakarta-Semarang-

Surabaya dan Jepara-Grobogan dimana Semarang merupakan 

Ibu Kota Provinsi Jawa Tengah. Dalam perekonomian, 

Kabupaten Kudus mempunyai banyak industri dari skala 

kecil, menengah maupun industri besar, sehingga Kabupaten 

Kudus berperan sebagai penyokong kabupaten-kabupaten di 

sekitarnya.  

Berdasarkan data Dinas Perindagkop pada tahun 2013, 

ada sebanyak 12.810 industri di Kabupaten Kudus yang 

mencakup industri besar, sedang, ataupun industri kecil atau 

rumah tangga. Selain dalam sektor industri, masyarakat 

Kabupaten Kudus juga memiliki wilayah yang berdominasi 

sebagai petani. Terdapat 4 (empat) kecamatan di antara 9 

(sembilan) kecamatan di Kabupaten Kudus yang memiliki 

luas panen terbesar. 

Berdasarkan penjelasan di atas maka perlu dilakukan 

peramalan tentang curah hujan untuk periode mendatang. 
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Peramalan curah hujan dapat dilakukan dengan model runtun 

waktu tunggal (univariat) dan dapat juga secara bersamaan 

(multivariat). Salah satu metode peramalan yang dapat 

digunakan dalam model bersama (multivariat) adalah Vector 

Autoregressive (VAR) (Desvina dan Ratnawati, 2014). 

Menurut Diani, Setiawan, dan Suhartono (2013) metode 

Vector Autoregressive (VAR) adalah metode peramalan dalam 

model time series yang bersifat multivariat. Terdapat juga 

metode yang digunakan dalam peramalan seperti ARIMA, 

VARIMA, STAR, GSTAR dan lain sebagainya. 

Penelitian yang dilakukan oleh Diani, Setiawan, dan 

Suhartono (2013) yang membandingkan metode VAR-NN dan 

G-STAR NN untuk peramalan curah hujan di Kabupaten 

Malang bahwa hasil model yang terbaik adalah dengan 

metode VAR-NN. Model G-STAR NN adalah pemodelan bentuk 

neural network yang didasarkan pada model G-STAR. Model 

ini mempunyai satu unit neuron pada output layer. Sedangkan 

model VAR NN merupakan pemodelan VAR yang berbentuk 

neural network. Model neural network adalah model yang 

terinspirasi oleh bagian otak manusia yang saling 

menghubungkan dan mengalirkan informasi dari setiap 

neuron. Maka dari itu model dari G-STAR NN dan VAR NN 

menggunakan variabel yang saling berkorespondensi. 
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Terdapat juga penelitian yang dilakukan oleh Insani 

(2015) menyebutkan bahwa model ARIMA Box-Jenkis adalah 

salah satu model linier yang mempunyai akurasi yang sesui 

untuk peramalan jangka pendek yaitu dalam peramalan 

tersebut dilakukan untuk 5 (lima) bulan kedepan dari data 

olahannya, sementara itu untuk jangka panjang memiliki 

keakuratan yang kurang baik. Solusi yang dapat dilaukan 

untuk memodelkan peramalan curah hujan dalam waktu 

jangka panjang adalah metode linier, contohnya regresi time 

series dan peramalan nonlinier seperti G-STAR. Kemudian 

terdapat juga penelitian yang dilakukan oleh Suhartono dan 

Wustqa (2006) tentang perbandingan kelayakan model VAR 

dan model STAR pada peramalan produksi teh di Jawa Barat 

memberikan hasil bahwa model VAR memiliki tahapan-

tahapan dalam membentuk model, yaitu tahap identifikasi, 

estimasi, dan cek diagnosa yang lebih tepat secara statistik 

dan lebih fleksible terutama dalam menentukan orde model 

yang tidak harus autoregressive orde tertentu. Hasil dari 

membandingkan ketepatan peramalan data produksi teh 

adalah model VAR memberikan ketepatan ramalan yang lebih 

baik dibanding model STAR. 

Peneliti berharap dapat membantu pemerintah 

Kota/Kabupaten Kudus dalam mempersiapkan penanganan 

becana banjir, tanah longsor, dan bencana lainnya, 
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mempersiapkan waktu tanam dan panen bagi petani, 

mempersiapkan kondisi yang mungkin atau tidak mungkin 

dalam proses produksi ataupun pengiriman barang bagi 

perusahaan, atau persiapan-persiapan lainnya bagi penduduk 

Kabupaten Kudus  yang disebabkan oleh tinggi dan 

rendahnya curah hujan di wilayah-wilayah Kabupaten Kudus. 

Berdasarkan permasalahan tersebut mendorong 

penulis untuk melakukan penelitian dengan mengangkat 

judul “Peramalan Curah Hujan Kabupaten Kudus dengan 

Metode VAR (Vector Autoregressive)”. Diharapkan hasil dari 

penelitian ini dapat bermanfaat bagi masyarakat maupun 

pemerintah Kota atau Kabupaten Kudus dalam penentuan 

kebijakan, proses pengambilan keputusan, dan membuat 

rencana masa depan. Peramalan dapat membantu 

permasalahan yang akan timbul seperti kekurangan air, 

ataupun bencana seperti banjir, tanah longsor, kekeringan, 

bahkan tsunami. Selain itu juga membantu dalam 

mempersiapkan yang akan terjadi di masa mendatang. 

Menurut teori, peramalan (forecasting) adalah perkiraan 

mengenai sesuatu yang belum terjadi (Desvina dan Ratnawati 

,2014). 

B. Rumusan Masalah 

Berdasarkan uraian latar belakang sebelumya, maka 

rumusan masalah yang diambil adalah: Bagaimana model dan 
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hasil peramalan curah hujan di Kabupaten Kudus dengan 

menggunakan metode VAR (Vector Autoregressive) di tahun 

2021? 

C. Tujuan Penelitian 

Untuk mengetahui model dan hasil  peramalan curah 

hujan di Kabupaten Kudus dengan menggunakan metode VAR 

(Vector Autoregressive) di tahun 2021. 

D. Manfaat Penelitian 

Mengetahui model peramalan dan hasil peramalan 

curah hujan di Kabupaten Kudus dengan menggunakan 

metode VAR (Vector Autoregressive) di tahun 2021. 
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BAB II 
Landasan Pustaka 

A. Landasan Teori 

1. Curah Hujan 

Menurut BMKG curah hujan merupakan ketinggian air 

hujan yang terkumpul dalam penakar hujan pada tempat 

yang datar yang tidak menyerap, tidak meresap dan tidak 

mengalir. Unsur hujan 1 (satu) milimeter (mm) artinya 

dalam luasan satu meter persegi pada tempat yang datar 

tertampung air hujan setinggi satu milimeter (mm) atau 

tertampung air hujan sebanyak satu liter. 

Indonesia berada di garis khatulistiwa dan sebagian 

besar daerahnya beriklim tropis sehingga memiliki dua 

musim yaitu kemarau dan penghujan. BMKG (2020) 

menjelaskan bahwa awal musim kemarau terjadi jika 

banyaknya curah hujan dalam satu dasarian (10 hari) 

kurang dari 50 mm dan diikuti oleh beberapa dasarian 

berikutnya. Sedangkan awal musim penghujan terjadi jika 

banyaknya curah hujan dalam satu dasarian (10 hari) 

sama atau lebih dari 50 mm dan diikuti oleh beberapa 

dasarian berikutnya. 

2. Alat Ukur Curah Hujan  

a. Alat Pengukur Curah Hujan Manual 

Pengukuran secara manual menggunakan rumus 

pembagian antara volume air hujan yang ada dalam 
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wadah penakar kemudian dibagi dengan luas wadah atau 

mulut penakar. Cara mengukur curah hujan harian dalam 

satu milimeter dilakukan 1 (satu) kali setiap pagi hari. 

pengukuran dilakukan dengan menggunakan alat yang 

bernama Observatorium/ombrometer. Alat ini memiliki 

tinggi 120 cm dan luas alasnya atau mulut penakar 100 

𝑐𝑚2. Rumus dari pengukuran curah hujan manual adalah 

sebagai berikut: 

Tinggi Curah Hujan: 
𝑉𝑜𝑙𝑢𝑚𝑒 

𝐿𝑢𝑎𝑠 𝑀𝑢𝑙𝑢𝑡 𝑃𝑒𝑛𝑎𝑘𝑎𝑟
 

 

b. Alat Pengukuran Curah Hujan Otomatis 

selain alat ukur manual juga terdapat alat pengukur 

curah hujan otomatia. Alat ini menggunakan prinsip 

pelampung dan jungkitan. Salah satunya yaitu Hellman 

dan Tipping-bucket gauge.  

 

Gambar 2. 2 Helman Rain 
Gauge 

 

Gambar 2. 1 Tipping- 

Bucket Gauge 
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Dibandingkan dengan alat ukur manual, alat ukur 

otomatis memiliki lebih banyak keunggulan, diantaranya 

yaitu diperolehnya hasil yang lebih teliti, dapat diketahui 

waktu kejadiannya, serta integritas hujan dalam periode 

pencatatannya dapat lebih dari satu hari karena 

menggunakan kertas pias. 

3. Kabupaten Kudus 

Letak geografis Kabupaten Kudus dibatasi oleh 4 

(empat) kabupaten di Jawa Tengah. Sebelah utara 

berbatasan dengan Kabupaten Jepara dan Kabupaten 

Pati. Sebelah Timur berbatasan dengan Kabupaten Pati. 

Sebelah Selatan berbatasan dengan Kabupaten Grobogan 

dan Pati. Sedangkan sebelah barat berbatasan dengan 

Kabupaten Demak dan Kabupaten Jepara (BPS, 2015). 

Kabupaten Kudus merupakan kabupaten yang tidak 

mempunyai laut karena diapit oleh 4 (empat) kabupaten. 

Namun Kabupaten Kudus mempunyai gunung yang 

sudah tidak aktif yaitu Gunung Muria. Berikut adalah 

gambar peta Kabupaten Kudus : 
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Gambar 2. 3 Peta Kabupaten Kudus 

Menurut BPS, Kabupaten Kudus memiliki iklim 

yang tropis dan temperaturnya sedang. Jumlah curah 

hujan yang dimiliki Kabupaten Kudus relatif rendah 

yaitu kisaran di bawah 3000 mm/tahun dan hari 

hujannya di bawah 150 hari/tahun (BPS, 2015). 

Dalam data BPS tahun 2016 menunjukkan 

banyaknya hari hujan perbulan di Kabupaten Kudus 

dari tahun 2011-2015 ditunjukkan hari hujan 

terbanyak pada bulan Januari yaitu tahun 2011 

sebesar 21 hari, tahun 2012 sebesar 18 hari, tahun 
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2013 sebesar 20 hari, tahun 2014 sebesar 24 hari 

dan tahun 2015 sebesar 17 hari. Sedangkan hari 

hujan terendah terdapat di bulan Agustus dan 

September yaitu pada tahun 2011 dan 2012 tidak 

terdapat hari hujan sedangkan tahun 2013-2014 

masing-masing sebesar 1(satu)  hari hujan, dan pada 

tahun 2015 sebesar 3 (tiga) hari hujan (BPS, 2016). 

Dengan data tersebut maka pada tahun 2011-2015 

puncak musim hujan pada bulan Januari dan puncak 

musim kemarau pada bulan Agustus dan September.  

Kabupaten Kudus merupakan kabupaten 

dengan jumlah kecamatan paling sedikit 

dibandingkan dengan kabupaten-kabupaten di Jawa 

Tengah yaitu  9 (sembilan) kecamatan. 

Kecaatamatam tersebut yaitu Kaliwungu, Kota, Jati, 

Undaan, Mejobo, Jekulo, Bae, Gebog, dan Dawe. 

Sektor industri merupakan tiang penyangga utama 

dari perekonomian di Kabupaten Kudus dengan 

kontribusi sebesar 61,44 persen terhadap PDRB 

Kabupaten Kudus (BPS,2015). Sektor industri ini 

didominasi oleh industri rokok, konveksi dan kertas 

yang mampu menyerap banyak tenaga kerja. 

Terdapat perusahaan besar yang berpusat di 

Kabupaten Kudus. Menurut Bappeda Kudus 
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(BappedaKudus n.d, diakses 28 Oktober 2020) 

perusahaan yang bergerak dalam industri rokok. 

Industri rokok tidak dapat terpisahkan dari 

Kabupaten Kudus sehingga Kabupaten Kudus 

disebut sebagai Kota Kretek. Kemudian industri 

bordir yang berdominasi di Kecamatan Kota. 

Berbagai jenis produk seperti bahan pakaian, 

accesoris, dan lain-lain yang dihasilkan dan 

dipasarkan untuk memenuhi pasar di dalam dan luar 

Kota Kudus. Selain itu terdapat juga industri 

konveksi yaitu produksi pakaian jadi yang terjual di 

pasar luar kota seperti Semarang, Surakarta, Jakarta, 

bahkan sampai Sumatra dan Kalimantan. Kemudian 

terdapat juga industri kertas dan percetakan yaitu 

PT Barutama yang memproduksi kertas security 

hologram, dan kertas tanpa karbon (NCR). Kemudian 

industri jenang yang menjadi makanan khas 

Kabupaten Kudus sekaligus menjadi mata 

pencaharian masyarakat Kabupaten Kudus terutama 

masyarakat Kecamatan Bae. Maka dari itu, sangat 

dibutuhkan peramalan curah hujan untuk 

mendukung proses pengiriman dan proses kerja 

perusahaan maupun masyarakat Kabupaten Kudus.   
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Menurut data BPS Kabupaten Kudus bahwa 

banyaknya produksi padi pada tahun 2019 dirinci 

menurut kecamatan di Kabupaten Kudus yaitu 

terbanyak di Kecamatan Undaan sebesar 75.092 ton. 

Terdapat empat kecamatan yang mempunyai 

produksi padi terbesar yaitu Kecamatan Undaan 

Sebesar 75.092 ton, kemudian Kecamatan Jekulo 

sebesar 28.282 ton, kemudian Kecamatan Kaliwungu 

sebesar 23.867 ton, dan Kecamatan Mejobo sebesar 

14.156 ton.  Sedangkan lima kecamatan lainnya 

hanya dapat memproduksi kurang dari 10.000 ton 

(BPS Kabupaten Kudus 2020, diakses 28 Oktober 

2020). Kecamatan Undaan merupakan kecamatan 

yang dipertahankan sebagai daerah pertanian yang 

subur dan sebagai kecamatan penyandang pangan 

sesuai dengan Rencana Tata Ruang Wilayah 

Kabupaten Kudus. Namun seiring berjalannya waktu, 

banyak lahan pertanian yang beralih fungsi sebagai 

perumahan, lahan industri, dan gudang.  

B. Penelitian yang relevan 

Pada penelitian ini, peneliti menelaah dari jurnal-jurnal 

terdahulu yang berkaitan dengan pembahasan yang akan 

dilakukan oleh peneliti. Hal ini sangat membantu dalam 

proses penelitian dan mencegah kesamaan dengan karya-
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karya ilmiah yang menjadi gambaran atau referensi dalam 

penelitian ini. Berikut adalah karya-karya ilmiah yang 

menjadi gambaran bagi peneliti dalam melakukan 

penelitiannya : 
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No. Jurnal Persamaan Perbedaan 
1. Jurnal berjudul: 

Penerapan Model Vector 
Autoregressive (VAR) 
untuk Peramalan Curah 
Hujan Pekanbaru, tahun 
2016 yang disusun oleh 
Ari Pani Desvina dan 
Ratnawati membahas 
tentang penentuan 
peramalan curah hujan 
dengan variabel lainnya 
yaitu kelembapan udara 
dan temperatur udara 
dengan menggunakan 
metode VAR. 

Persamaan jurnal ini 
dengan penelitian ini 
adalah metode yang 
digunakan sama, yaitu 
metode VAR.   

Perbedaan dari jurnal ini 
dengan penelitian ini adalah 
variabel yang digunakan 
adalah komponen-komponen 
yang mempengaruhi naik 
turunnya curah hujan secara 
umum yaitu temperatur udara 
dan kelembapan udara, 
sedangkan pada penelitian ini 
menggunakan variabel curah 
hujan di masing-masing post 
hujan Kabupaten Kudus 
dengan tujuan mengetahui 
nilai peramalan curah hujan 
tersebut berdasarkan nilai 
tinggi rendahnya dari post 
hujan satu dengan post hujan 
lainnya. Kemudian data yang 
digunakan dalam jurnal ini 
adalah data harian, sedangkan 
dalam penelitian ini adalah 
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data bulanan. Model VAR yang 
diperoleh dalam jurnal ini 
adalah model VAR(2) maka 
artinya model optimal pada 
lag ke 2 sedangkan pada 
penelitian ini model VAR yang 
diperoleh adalah VAR(1). 

2. Jurnal Berjudul: 
Pemodelan VAR-NN dan 
GSTAR-NN untuk 
Peramalan Cura Hujan di 
Kabupaten Malang, tahun 
2013 oleh Kadek Ardya 
Novi Diani, Setiawan, dan 
Suhartono membahas 
tentang metode NN 
(Neural Network) yang 
diterapkan pada 
pemodelan peramalan 
curah hujan di Kabupaten 
Malang dan 
membandingkan metode 

Persamaan dalam jurnal 
ini dengan peneliian ini 
adalah dalam proses 
peramalan sebelum pada 
tahap neuron adalah 
sama yaitu menggunakan 
VAR. 

Perbedaan jurnal ini dengan 
penelitian ini adalah dalam 
jurnal ini lebih terfokus pada 
perbandingan antara metode 
VAR-NN dengan GSTAR-NN 
sedangkan pada penelitian ini 
terfokus pada prose 
peramalan menggunakan 
metode VAR dan nilai hasil 
peramalan. Selain itu tahapan 
dalan proses peramalan juga 
berbeda.  
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mana yang memberikan 
hasil ramalan terbaik 
antara metode VAR-NN 
dan G-STAR NN . 

3. Jurnal Berjudul: 
Pemodelan Pencemaran 
Udara Menggunakan 
Metode Vector 
Autoregressive(VAR) di 
Provinsi Riau, tahun 2015 
oleh Ari Pani Desvina dan 
Maryam Julliana D 
membahas tentang 
peramalan kualitas udara 
di Provinsi Riau. 

Persamaan dalam jurnal 
ini dengan penelitian ini 
adalah metode yang 
digunakan sama dalam 
proses pemodelan. Model 
VAR yang diperoleh juga 
sama yaitu VAR(1).  

Perbedaan dalam jurnal ini 
dengan penelitian ini adalah 
variabel yang digunakan 
berbeda, dalam jurnal ini 
menggunakan unsur-unsur 
yang mempengaruhi 
pencemaran udara dan unsur 
meteorologi seperti curah 
hujan, suhu udara, dan 
hostpot. Kemudian dalam 
jurnal tidak sampai 
meramalkan hanya 
menganalisis sebab akibat dan 
pemebntukan model.  

4 Jurnal Berjudul: Evaluasi 
Kebaikan Model VAR 
dibandingkan Model STAR 
pada Peramalan Produksi 

Persamaan jurnal ini 
dengan penelitian ini 
adalah terletak pada 
penggunaan metode VAR.  

Perbedaan dalam jurnal ini 
dengan penelitian ini adalah 
dalam jurnal ini 
membandingkan metode satu 
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Teh di Jawa Barat, tahun 
2006 oleh Suhartono dan 
Dhoriva Urwatul Wutsqa. 
Dalam jurnal ini 
membahas perbandingan 
metode antara VAR 
dengan STAR dalam 
proses peramalan 
produksi teh di Jawa 
Barat. 

dengan metode lainnya., 
sedangkan dalam penelitian 
ini hanya terfokus pada satu 
metode dan analisis nya. 

5 Jurnal Berjudul: Model 
Vektor Autoregressive 
untuk Peramalan Curah 
Hujan di Indramayu, tahun 
2011 oleh Dewi Retno Sari 
Saputro, Aji Hamim 
Wigena, dan Anik 
Djuraidah membahas 
peramalan curah hujan 
ditiga lokasi di Indramayu. 

Persamaan jurnal ini 
dengan penelitian ini 
adalah metode yang 
digunakan sama yaitu 
VAR, kemudian variabel 
yang digunakan juga sama 
berupa curah hujan 
disebuah lokasi, selain itu 
model yang diperoleh 
berupa VAR(1). 

Perbedaan dari jurnal ini 
dengan penelitian ini adalah 
data yang digunakan dalam 
jurnal ini berupa tahunan, 
sedangkan pada penelitian ini 
berupa data bulanan.  
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BAB III 

METODE PENELITIAN 

A. Jenis Penelitian 

Jenis penelitian yang digunakan adalah penelitian 

kuntitatif. Penelitian kuantitatif pada umumnya adalah 

penelitian yang mengandung angka dan nilai. Menurut 

Sugiyono (2016) disebut penelitian kuantitatif karena data 

penelitian berupa angka-angka dan analisis menggunakan 

metode statistik. 

 Penelitian ini berupaya meramalkan tingkat intensitas 

curah hujan di Kabupaten Kudus menggunakan data sekunder 

yang di ambil dari Badan Meteorologi, Klimatologi, dan 

Geofisika (BMKG) kelas 1 Semarang pada tahun 2019-2020. 

B. Variabel Penelitian  

Variabel penelitian yaitu segala hal yang telah 

ditetapkan oleh seorang peneliti untuk dipelajari dan dibahas 

dalam sebuah penelitian sehingga dapat diperoleh informasi 

dari hal tersebut kemudian dapat ditarik sebuah kesimpulan 

(Sugiyono, 2016).  

Penelitian ini menggunakan variabel dari 7 Stasiun Post 

Hujan di Kabupaten Kudus yaitu Stasiun Post Hujan Kudus 

Kota, Stasiun Post Hujan Jekulo, Stasiun Post Hujan 

Kedunggupit, Stasiun Post Hujan Karanggayam, Stasiun Post 

Hujan Besito, Stasiun Post Hujan Colo, Stasiun Post Hujan 

Cendono pada tahun 2019-2020 yang digunakan untuk data 
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pemodelan VAR dan tahun 2021 untuk data hasil dari 

peramalan.  

C. Metode Pengumpulan Data 

Data yang digunakan dalam penelitian ini adalah data 

stasiun curah hujan Kabupaten Kudus yaitu  Stasiun Post 

Hujan Kudus Kota, Stasiun Post Hujan Jekulo, Stasiun Post 

Hujan Kedunggupit, Stasiun Post Hujan Karanggayam, Stasiun 

Post Hujan Besito, Stasiun Post Hujan Colo, Stasiun Post Hujan 

Cendono pada tahun 2019-2020. 

Metode pengumpulan data yang digunakan adalah 

metode dokumentasi, yaitu mengumpulkan data dalam 

bentuk tertulis, gambar, atau karya-karya monumental 

seperti buku, jurnal, artikel yang berkaitan dengan topik yang 

diteliti. Metode dokumentasi yang digunakan oleh peneliti 

adalah data yang berkaitan dengan curah hujan di Kabupatem 

Kudus tahun 2019-2020. Data tersebut merupakan data 

sekunder yang diperoleh dari BMKG kelas 1 Semarang. Data 

sekunder merupakan data yang sudah jadi dan dikumpulkan 

oleh pihak lain dengan metode tertentu.  

D. Metode Analisis Data 

1. Metode Vector Autoregressive (VAR) 

a. Pengertian Vector Autoregressive  (VAR) 

VAR adalah suatu sistem persamaan dinamis yang 

menggunakan pendugaan suatu peubah pada periode 
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tertentu tergantung pada pergerakan peubah tersebut 

dan peubah-peubah lain yang terlibat dalam sistem 

pada periode sebelumnya (Enders, 1995). Metode VAR 

adalah metode pendekatan nonstruktural yang 

menjelaskan hubungan kausalitas, yaitu hubungan 

sebab akibat antar variabel dalam sistem. Penjelasan 

dari Siregar dan Irawan (seperti dikutip dalam Basuki, 

2018)  bahwa VAR adalah sistem persamaan yang 

menggambarkan setiap variabel sebagai fungsi linier 

dari konstanta dan nilai lag (lampau) dari variabel itu 

sendiri, serta nilai lag dari variabel yang ada dalam 

sistem. Variabel penjelas dalam VAR meliputi nilai lag 

seluruh variabel tak bebas dalam sistem VAR yang 

membutuhkan identifikasi retriksi untuk mencapai 

persamaan melalui interpretasi persamaan.  Dalam 

metode VAR ini semua variabel dalam model dianggap 

saling ketergantungan satu sama lain, maka semua 

variabel dalam metode VAR dianggap variabel endogen 

(dependen).  

Secara umum model VAR dengan n variabel 

endogen dapat ditulis sebagai berikut (Widarjono, 

2018): 

𝑌1𝑡 = 𝛼01 + ∑ 𝛼𝑖1𝑌1𝑡−𝑖 + ∑ 𝛽𝑖1𝑌2𝑡−𝑖 + ⋯ +
𝑝
𝑖=1

𝑝
𝑖=1

∑ 𝜂𝑖1𝑌𝑛𝑡−𝑖 + 𝑒1𝑡
𝑝
𝑖=1      (1) 
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  ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ ⋯ 

𝑌𝑛𝑡 = 𝛼0𝑛 + ∑ 𝛼𝑖𝑛𝑌1𝑡−𝑖 + ∑ 𝛽𝑖𝑛𝑌2𝑡−𝑖 + ⋯ +
𝑝
𝑖=1

𝑝
𝑖=1

∑ 𝜂𝑖𝑛𝑌𝑛𝑡−𝑖 + 𝑒𝑛𝑡
𝑝
𝑖=1     (2) 

Bentuk ringkas menggunakan notasi matriks sebagai 

berikut: 

𝑌𝑡 = 𝐴0 + 𝐴1𝑌𝑡−1 + 𝐴2𝑌𝑡−2 + ⋯ + 𝐴𝑝𝑌𝑡−𝑝 + 𝑒𝑡 (3) 

     atau  

 𝑌𝑡 = 𝐴0 + ∑ 𝐴𝑛𝑌𝑡−𝑛 + 𝑒𝑡
𝑝
𝑛=1     (4) 

Keterangan: 

𝑌1𝑡 , 𝑌2𝑡 , ⋯ , 𝑌𝑛𝑡  = Variabel yang diamati dalam waktu 

t 

𝛼0 = Intercept 

𝛼𝑖1, 𝛽𝑖1, ⋯ , 𝜂𝑖1 = Koefisien variabel Y yang diamati 

dalam waktu t dari leg ke i sampai p. 

𝑒1𝑡 , 𝑒2𝑡, ⋯ , 𝑒𝑛𝑡 = Variabel gangguan dalam   waktu t 

𝑌𝑡 = Vektor dari n variabel dalam waktu 

t 

𝑝  = Banyak lag (kelambanan) 

𝑒𝑡 = Vektor variabel gangguan dalam 

waktu t 

𝑛 = Jumlah variabel yang diamati 

b. Tahapan Penyusuna Model VAR 

Menurut Widarjono (2018) proses pembentukan 

model VAR ditunjukkan sebagai berikut: 
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Gambar 3. 1 Tahap Pembentukan Model VAR 

1.) Melakukan Uji Kestasioneran Data  

Tahap pertama dalam membuat model VAR 

adalah identifikasi data time series apakah sudah 

stasioner atau tidak. Data stasioner yaitu data 

runtun waktu yang tidak mengandung unit roots 

Data Time Series 

Stasioner Tidak Stasioner 

VAR Bentuk Level Stasioner dideferensi 
Data 

VAR Bentuk Diferensi 

VECM 

tidak 

Uji Stasioner 

Kointegrasi 
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(akar-akar unit). Dalam Buku Widarjono (2018) 

dijelaskan jika data sudah stasioner dalam tingkat 

level maka data asli sudah langsung dapat diestimasi 

dalam bentuk model VAR biasa (unresricted VAR). 

Namun, jika data tidak stasioner maka terdapat 2 

(dua) kemungkinan yang harus dilakukan, yaitu 

pertama adalah melakukan difference pada data asli 

sehingga data menjadi satsioner, selanjutnya 

melakukan estimasi model VAR pada tingkat 

difference (VAR in difference form). Kedua, tidak 

melakukan differencing tetapi merestriksi VAR 

dengan persamaan koentegrasi sehingga diperoleh 

model Vector Error Correction Model (VECM). 

Uji stasioner data bisa dilakukan dengan 

menggunakan uji akar unit ADF (Augmented Dicky 

Fuller) atau PP (Philips-Perron) (Widarjono, 2018).  

Uji ADF sebenarnya perkembangan dari uji DF 

yang dilakukan oleh Dickey-Fuller. Uji ADF ini biasa 

dikenal dengan uji akar unit. Adapun formulasi uji 

ADF adalah sebagai berikut (Widarjono, 2018): 

∆𝑌𝑡 = 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=1    (5) 

∆𝑌𝑡 = 𝛼0 + 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=1   (6) 

∆𝑌𝑡 = 𝛼0 + 𝛼1𝑇 + 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=1  (7) 

Keterangan : 
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𝛼0 = Intercept 

𝑌𝑡 = variabel yang diamati dalam waktu t 

∆𝑌𝑡 = 𝑌𝑡 − 𝑌𝑡−1 

𝑇 = trend waktu 

𝛾 = koefisien variabel 𝑌 pada waktu 𝑡 − 1 

𝛽𝑖= koefisien variabel ∆𝑌 pada waktu 𝑡 − 𝑖 

𝛼1= koefisien variabel trend waktu 

𝑝 = jumlah lag 

𝑒𝑡 = variabel gangguan  

Persamaan (5) merupakan uji tanpa konstanta 

dan trend waktu. Persamaan (6) merupakan uji 

dengan konstanta tanpa trend waktu. Persamaan (7) 

merupakan uji dengan konstanta dan trend waktu. 

Untuk mengetahui apakah data stasioner atau tidak 

yaitu dengan cara melihat nilai statistik ADF pada 

software yang digunakan kemudian membandingkan  

dengan nilai kritis statistik Mackinnon, atau dengan 

melihat nilai probabilitas yang terdapat dalam 

output shoftwere yang digunakan. Data dikatakan 

stasioner jika nilai ADF lebih besar dari nilai 

kritisnya atau jika nilai probabilitas lebih kecil dari 

nilai 𝛼 maka data stasioner. Pada persamaan di atas, 

nilai statistik ADF ditunjukkan oleh nilai t statistik 

koefisien 𝛾𝑌𝑡−1 pada persamaan (5)-(7).  
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Adapun persamaan uji akar unit dari Phillips-

Perron adalah sebagai berikut (Widarjono, 2018) : 

∆𝑌𝑡 =  𝛾𝑌𝑡−1 + 𝑒𝑡     (8) 

∆𝑌𝑡 = 𝛼0 +  𝛾𝑌𝑡−1 + 𝑒𝑡    (9) 

∆𝑌𝑡 = 𝛼0 + 𝛼1𝑇 +  𝛾𝑌𝑡−1 + 𝑒𝑡   (10) 

Keterangan : 

𝛼0 = Intercept 

𝑌𝑡−1  = Variabel yang diamati dalam waktu 

t 

∆𝑌𝑡  = 𝑌𝑡 − 𝑌𝑡−1 

𝑇 = Trend waktu 

𝛾 = Koefisien variabel 𝑌𝑡−1 

𝛼1 = Koefisien variabel T 

𝑒𝑡 = Variabel gangguan dalam waktu t 

Pada uji PP tidak jauh beda dengan uji ADF. 

Dalam menentukan apakah data sudah stasioner 

atau tidak, yaitu degan cara membandingkan antara 

nilai statistik PP dengan nilai kritisnya yaitu 

distribusi statistik Mackinnon. Nilai statistik PP 

ditunjukkan oleh nilai t statistik koefisien  𝛾𝑌𝑡−1 

pada persamaan (8)-(10). Data dikatakan stasioner 

jika nilai absolut PP lebih besar dari nilai kritisnya 

dan sebaliknya.   
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Pada pembahasan uji stasioner, jika terdapat 

data yang tidak stasioner pada tingkat level maka 

data harus ditransformasikan data nonstasioner agar 

menjadi data yang stasioner. Karena jika data tidak 

stasioner maka akan diperoleh regresi lancung, 

untuk menghindarinya maka data harus 

ditransformasikan menjadi data yang stasioner.  

Dalam uji ADF jika menghasilkan data yang 

nonstasioner maka dilakukan proses diferensi data 

agar data menjadi stasioner. Uji stasioner data 

melalui diferensi ini disebut uji derajat integrasi. 

Adapun formulasi uji derajat integrasi dari ADF 

sebagai berikut: 

∆2𝑌𝑡 = 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆2𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=2   (11) 

∆2𝑌𝑡 = 𝛼0 + 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆2𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=2  (12) 

∆2𝑌𝑡 = 𝛼0 + 𝛼1𝑇 + 𝛾𝑌𝑡−1 + ∑ 𝛽𝑖∆2𝑌𝑡−𝑖 + 𝑒𝑡
𝑝
𝑖=2 (13) 

Sedangkan uji derajat integrasi dari PP sebagai 

berikut : 

∆2𝑌𝑡 =  𝛾𝑌𝑡−1 + 𝑒𝑡     (14) 

∆2𝑌𝑡 = 𝛼0 +  𝛾𝑌𝑡−1 + 𝑒𝑡    (15) 

∆2𝑌𝑡 = 𝛼0 + 𝛼1𝑇 +  𝛾𝑌𝑡−1 + 𝑒𝑡  (16) 

Keterangan : 

 ∆2𝑌𝑡 = ∆𝑌𝑡 − ∆𝑌𝑡−1 

𝛼0 = Intercept 
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𝛼1 = Koefisien variabel trend waktu 

𝑝 = Banyaknya leg 

𝛾 = Koefisien variabel 𝑌𝑡−1 

𝛽𝑖 = Koefisien variabel ∆2𝑌𝑡−𝑖  

𝛼1 = Koefisien variabel T 

𝑇 = Trend waktu 

𝑒𝑡 = Variabel gangguan dalam waktu t 

Seperti pada uji akar-akar unit sebelumnya, 

dengan membandingkan nilai statistik ADF atau PP 

terhadap nilai kritis distribusi Mackinnon atau 

membandingkan nilai probabilitas terhadap nilai 𝛼   

maka pada tingkat derajat keberapa data dikatakan 

stasioner. Jika nilai probabilitas lebih kecil dari 𝛼   

pada diferensi tingkat pertama maka data dikatakan 

stasioner pada tingkat pertama dan model VAR yang 

terbentuk adalah model VAR(1). Namun, jika nilai 

probabilitas lebih besar dari nilai 𝛼 maka uji derajat 

integrasi harus dilanjutkan pada diferensi yang lebih 

tinggi lagi sampai diperoleh data yang stasioner.  

2.) Melakukan Uji Kointegrasi 

Model VAR dapat digunakan jika dalam 

variabel-variabelnya mengandung unit root dan 

tidak berkointegrasi satu sama lain (Windasari, 

2018). Uji kointegrasi dilakukan jika data stasioner 
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berada di tingkat first difference. Pada dasarnya uji 

kointegrasi digunakan untuk melihat keseimbangan 

jangka panjang diantara variabel-variabel yang 

diamati. Suatu data yang secara individu tidak 

stasioner, namun saat dihubungkan secara linier 

data tersebut menjadi stasioner, hal disebut dengan 

data terkointegrasi (Windasari, 2018). 

Penjelasan dari Engle-Granger (seperti yang 

dikutip dalam Widarjono, 2018) bahwa variabel 

yang nonstasioner dapat menyebabkan adanya 

hubungan jangka panjang antara vairiabel di dalam 

model VAR. Dalam hal ini, maka langkah berikutnya 

dalam membentuk model VAR adalah uji kointegrasi. 

Hal ini dilakukan untuk mengetahui keberadaan 

hubungan antar variabel dalam model VAR. Pada 

tahap ini akan diketahui apakah model adalah VAR 

tingkat diferensi jika tidak terdapat kointegrasi atau 

VECM jika terdapat kointegrasi.  

Pengujian adanya kointegrasi atau tidak dapat 

dilakukan dengan menggunakan uji Engle-Granger 

dan uji Johansen (Widarjono, 2018). 

 Uji Engle-Granger  

Persamaan uji Engle-Granger adalah sebagai 

berikut: 

Data Time Series 

Uji Stasioner Data 

Stasioner 

VAR Bentuk Level 

Tidak Stasioner 

Stasioner dideferesi Data 

Terjadi Kointegrasi VAR Bentuk Diferensi 

VECM 

tidak 
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∆𝑒𝑡 = 𝛽1𝑒𝑡−1     (17) 

∆𝑒𝑡 = 𝛽1𝑒𝑡−1 + ∑ 𝛼𝑖∆𝑒𝑡−𝑖+1
𝑝
𝑖=2   (18) 

Keterangan : 

∆𝑒𝑡 = 𝑒𝑡 − 𝑒𝑡−1 

∆𝑒𝑡−1  = 𝑒𝑡−1 −  𝑒𝑡−2 

𝑒𝑡  = variabel gangguan 

𝛽1  = koefisien variabel gangguan dalam 

waktu t-1 

𝛼𝑖  = koefisien variabel ∆𝑒𝑡−𝑖+1 

Berdasarkan hasil estimasi nilai statistik DF 

dan ADF kemudian dibandingkan dengan nilai 

kritisnya. Nilai statistik DF dan ADF diperoleh 

dari koefisien 𝛽1. Variabel dalam model VAR 

dikatakan tidak berkointegrasi jika nilai 

statistiknya lebih besar dari nilai kritisnya dan 

sebalinya, variabel dikatakan terdapat kointegrasi 

jika nilai statistiknya  lebih kecil dari nilai 

kritisnya. Dalam hal ini nilai kritis statistik DF dan 

ADF tidak lagi digunakan karena variabel 

gangguannya didasarkan dari parameter 

kointegrasi. Untuk keperluan ini Engle-Granger 

telah mengembangkan nilai kritis statistik 

tersendiri. Saat ini beberapa software 

ekonometrika telah menyediakan nilai kritisnya.  
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 Uji Johansen  

Uji Johansen dapat digunakan untuk 

menentukan kointegrasi sejumlah variabel 

(vektor). Untuk menjelaskan uji Johansen 

diperhatikan model Autoregresif dengan orde p 

sebagai berikut : 

𝑌𝑡 = 𝐴1𝑌𝑡−1 + ⋯ + 𝐴𝑝𝑌𝑡−𝑝 + 𝐵𝑋𝑡 + 𝑒𝑡 (19) 

Keterangan : 

𝑌𝑡  = vektor k dari variabel I(1) 

nonstasioner 

𝑋𝑡 =  vektor  d dari variabel deterministik 

𝐴1, ⋯ , 𝐴𝑝= koefisien variabel 𝑌𝑡−1, ⋯ , 𝑌𝑡−𝑝 

𝐵 = Koefisien vektor 𝑋𝑡 

𝑒𝑡 = vektor variabel gangguan 

Berdasarkan persamaan (19) dapat ditulis 

kembali menjadi : 

∆𝑌𝑡 = ∑ Γ𝑖
𝑝−1
𝑖=1 Δ𝑌𝑡−1 + ΠY𝑡−𝑘 + 𝐵𝑋𝑡 + 𝑒𝑡 (20) 

Keterangan : 

Π = ∑ 𝐴𝑖 − 1
𝑝
𝑖=1   

Γ = ∑ 𝐴𝑗
𝑝
𝑗=𝑖+1   

Hubungan kointegrasi (jangka panjang) 

dijelaskan di dalam matriks dari sejumlah p 

variabel. Ketika 0 < 𝑟𝑎𝑛𝑘 = 𝑟 < (Π) = 𝑟 < 𝑝 

maka Π terdiri dari matriks Q dan R dengan 
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dimensi r x p sehingga Π = QR′. Matriks R terdiri 

dari r dimana 0 < 𝑟 < 𝑝 adalah vektor kointegrasi 

sedangkan Q merupakan matriks vektor 

parameter error correction. Johansen menjelaskan 

bahwa estimator maximum likelihood untuk Q dan 

R dan uji statistik adalah untuk menentukan 

vektor kointegrasi r. Keputusan ada atau tidaknya 

kointegrasi dalam variabel didasarkan pada nilai 

dari uji likelihood ratio (LR). Dalam uji LR, jika 

nilai hitung LR lebih besar dari nilai kritisnya 

maka artinya terdapat kointegrasi antar variabel, 

namun jika sebaliknya yaitu nilai LR lebih kecil 

dari nilai kritisnya maka tidak terdapat 

kointegrasi antar variabel. Nilai kritis LR 

diperoleh dari tabel yang dikembangkan oleh 

Johansen dan Juselius. Nilai hitung LR dihitung 

berdasarkan formula sebagai berikut : 

  𝑄𝑡 = −𝑇 ∑ log (1 − 𝜆𝑖)𝑘
𝑖=𝑟+1    (21) 

Untuk r = 0, 1, . . ., k-1 dimana 𝜆𝑖 adalah nilai i 

eigenvalue paling besar. 

Uji kointegrasi juga dapat dilihat dari nilai 

maximum eigenvalue statistic. Maximum 

eigenvalue statistic  dapat dihitung dari trace 

statistic sebagai berikut : 
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𝑄𝑚𝑎𝑥 = −𝑇(1 − 𝜆𝑖+1) = 𝑄𝑡 − 𝑄𝑡+1   (22) 

3.) Pemilihan Panjang Lag 

Salah satu permasalan dalam model VAR 

adalah penentuan panjang lag. Menentukan panjang 

lag yang optimum digunakan untuk mengetahui 

pengaruh dari setiap vaeriabel terhadap variabel 

yang lain dalam sistem VAR. Panjang lag optimal 

dapat ditentukan dengan menggunakan beberapa 

metode yaitu nilai koefisien determinasi yang 

disesuaikan (𝑅2̅̅̅̅ ), Akaike Information Criteria (AIC), 

dan Schwarz Information Creterion (SIC) (Widarjono, 

2018). Panjangnya lag yang dipilih didasarkan pada 

nilai AIC dan SIC terkecil. Dalam penelitian ini 

menggunakan metode Akaike Information Criteria 

(AIC) dengan rumus formulasi sebagai berikut:  

Formulasi Akaike Information Criterion (AIC) 

𝐴𝐼𝐶 = log (
𝑆𝑆𝑅

𝑛
) +

2𝑘

𝑛
   (25) 

Keterangan : 

SSR = jumlah residual kuadrat (sum of 

squared residual) 

k = jumlah variabel 

n = jumlah observasi 
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4.) Jika data sudah stasioner tanpa melakukan 

tahap deferensiasi maka data dapat langsung 

digunakan untuk pemodelan bentuk VAR.  

5.) Melakukan Analisis Terhadap Model VAR. 

Analisis model VAR terdapat uji kausalitas 

Granger. Uji kausilatas Granger adalah uji hubungan 

sebab akibat antar variabel endogen di dalam model 

VAR. Terdapat tiga kemungkinan yaitu pertama 

variabel X menyebabkan Y, yang ke dua variabel Y 

menyebabkan X, dan yang ke tiga X dan Y memiliki 

hubungan timbal balik (Windasari, 2018). 

Ada tidaknya kausalitas pada varaibel, dapat 

dilihat dari F hitung atau nilai probabilitasnya. Jika 

nilai F hitung lebih besar dari nilai F tabel maka 

hipotesis nol ditolak yang artinya terdapat pengaruh 

antara variabel independen dan jika sebaliknya 

maka tidak terdapat pengaruh antara variabel 

independennya (Widarjono, 2018). 

Uji kausalitas adalah uji hubungan dua arah. 

Maka, jika terjadi kausalitas didalam sistem, maka di 

dalam model tidak terdapat variabel independen 

(eksogen), semua variabel merupakan variabel 

dependen (endogen). Model persamaan Kausalitas 

Granger adalah sebagai berikut: 
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𝑌𝑡 = ∑ 𝛼𝑖𝑌𝑡−𝑖 + ∑ 𝛽𝑖𝑋𝑡−𝑖 + 𝑒1𝑡
𝑛
𝑖=1

𝑛
𝑖=1  (26) 

𝑋𝑡 = ∑ 𝛿𝑖𝑋𝑡−𝑖 + ∑ 𝜑𝑖𝑌𝑡−𝑖 + 𝑒2𝑡
𝑚
𝑖=1

𝑚
𝑖=1  (27) 

 

Keterangan : 

X= Variabel 1 

Y = Varaibel 2  

Langakah pertama untuk menguji apakah 

variabel satu mempengaruhi variabel lainnya dan 

sebaliknya maka persamaannya adalah sebagai 

berikut: 

Persamaan unrestricted :  

𝑌𝑡 = ∑ 𝛼𝑖𝑌𝑡−𝑖 + ∑ 𝛽𝑖𝑋𝑡−𝑖 + 𝑒1𝑡
𝑛
𝑖=1

𝑛
𝑖=1   (28) 

Persamaan restricted :  

𝑌𝑡 = ∑ 𝜑𝑖𝑌𝑡−𝑖 + 𝑒2𝑡
𝑚
𝑖=1     (29) 

Persamaan unrestricted :  

𝑋𝑡 = ∑ 𝛼𝑖𝑋𝑡−𝑖 + ∑ 𝛽𝑖𝑌𝑡−𝑖 + 𝑒1𝑡
𝑛
𝑖=1

𝑛
𝑖=1   (30) 

Persamaan restricted :  

𝑋𝑡 = ∑ 𝛿𝑖𝑋𝑡−𝑖 + 𝑒2𝑡
𝑚
𝑖=1     (31) 

Keputusan apakah variabel satu mempengaruhi 

variabel lainnya dan sebaliknya maka digunakan uji 

F. Nilai F hitung diperoleh dari formula sebagai 

berikut: 

𝐹 =
𝑆𝑆𝑅𝑅 − 𝑆𝑆𝑅𝑢/𝑞

𝑆𝑆𝑅𝑢/(𝑛 − 𝑘)
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Dimana 𝑆𝑆𝑅𝑅 𝑑𝑎𝑛 𝑆𝑆𝑅𝑢 adalah nilai residual sum of 

squares di dalampersamaan unrestricted dan 

restricted, q adalah jumlah lag, n adalah jumlah 

observasi, k adalah jumlah parameter yang di amati 

di dalam persamaan unrestrected.  

6.) Pendugaan Model dan Pemeriksaan Kebaikan 

Model. 

Langkah selanjutnya dalam penentuan model 

VAR setelah diperoleh model VAR(p) sesuai dengan 

data adalah uji kelayakan model. Model VAR 

merupakan model yang mengikuti model OLS  

(Ordinary Least SquareI). Maka dari itu, uji kelayakan 

model didasarkan pada uji Asumsi Klasik. Jika uji 

asumsi klasik terpenuhi maka model sudah layak. 

7.) Melakukan Peramalan Model VAR. 

Peramalan dengan metode VAR merupakan 

ekstrapolasi nilai saat ini dan masa depan seluruh 

variabel dengan menggunakan data pada masa lalu. 

c. Jenis-jenis Metode VAR non Struktural 

1.) VAR yang Tak Terestriksi 

Model VAR tak terekstriksi adalah model 

dimana setelah dilakukan uji stasioneris data 

menunjukkan data stasioner, maka model VAR 

disebut dengan VAR in level. Namun dalam beberapa 
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kasus seringkali menunjukkan tidak satsioner. 

Apabila hal ini terjadi maka perlu dilakukan uji 

stasioner data pada tingkat difernsi. Jika setelah 

dilakukan uji stasioner data pada tingkat diferensi 

kemudian data menunjukkan stasioner namun 

secara teoritis tidak terjadi hubungan antar variabel 

karena tidak menunjukkan adanya kointegrasi maka 

modelnya disebut dengan model VAR in difference 

(Widarjono, 2018). 

2. Metode Komputerisasi 

Metode komputerisasi adalah metode pengolahan 

data dengan bantuan softwere komputer. Dalam 

penelitian ini softwere yang digunakan adalah Eviews. 

 Langkah-langkah peramalan menggunakan 

 program Eviews: 

 a. Import Data  

  Tampilan icon pada program Eviews di tunjukkan 

 pada gambar berikut :  

  Langkah pertama dalam 

menggunakan program  eviews adalah 

memasukkan data pada workfile baru  dengan langkah 

klik File > New > Workfile , maka akan  muncul tampilan 

 sebagai berikut : 
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Gambar 3. 2 Workfile Create 

 Workfile structure type digunakan untuk meenentukan 

 struktur data yang digunakan. Terdapat 3 pilihan yaitu : 

 1.)  Unstructured atau undate: data yang tidak   

 terstruktur atau tidak ditentukan waktunya untuk data 

 time series. 

2.) Dated: menentukan waktu data time series. 

3.) Balance Panel: menentukan data untuk data panel. 

Pada penelitian ini data yang digunakan adalah 

data time series maka yang dipilih adalah Dated. 

Selanjutnya pada Date Specification pilihlah periode 

sesuai data yang digunakan. Karena pada penelitian ini 

menggunakan periode bulanan maka pilih monthly. 

Pada Start Date isilah periode awal dari data yang 
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digunakan misalkan pada penilitian ini menggunakan 

data awal tahun 2019. Kemudian pada End Date isilah 

periode terakhir+periode yang akan diramalkan dari 

data yang akan digunakan. Pada penelitian ini periode 

terakhir adalah atahun 2020+1 tahun data yang akan 

diramalkan. Sehingga pada end date diisi 2021. Maka 

akan muncul tampilan sebagai berikut:  

 

 

  

 

 

 

 

Gambar 3. 3 Workfile Utitled 

Pada Workfile UTILITED masukkan data series 

dengan mengcopy data yang akan digunakan di excel 

kemudian kembali ke eviews dan pilih Qick > Empety 

group. Maka akan muncul tampilan sebagai berikut:  
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Gambar 3. 4 Database 

b. Uji Stasioneritas  

 Setelah data di masukkan dalam workfile 

maka langkah selanjutnya yaitu melakukan uji Stasioner. 

Uji ini adalah syarat utama dalam melakukan peramalan 

atau pemodelan menggunakan metode VAR. Langkah-

langkah dalam melakukan uji stasioner menggunakan 

eviews adalah sebagai berikut: 

Klik Data yang ingin di uji > View > Unit Root Test  

 

 

 

 

Gambar 3. 5 Unit Root Test 
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Setelah itu akan muncul gambar 3.5. Pada Test type  pilih 

Augmented Dickey-fuller. Kemudian pada Test for unit 

root in pilih level. Maka akan muncul output dari unit 

roor test. Jika pada output diperoleh data tidak stasioner 

pada tingkat level, maka data diuji lagi dengan langkah 

seperti pada langkah awal hanya saja pada Test for unit 

root in pilih 1st different. 

c. Uji Kausalitas Granger 

 langkah-langkah dalam melakukan uji Kausalitas 

Granger adalah sebagai berikut: 

Blok semua variabel yang akan digunakan kemudian klik 

kanan, pilih Open > as Group 

 

 

 

 

Gambar 3. 6 Uji Kausalitas Granger 
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Kemudian langkah selanjutnya yaitu klik View > Granger 

Kausality > Lag optimum isikan lag yang sudah optimum 

> OK, maka akan terlihat output dari uji Kausalitas Granger. 

d. Uji Lag Optimum 

 Pada uji lag optimum dilakukan untuk mencari lag 

yang paling optimum dalam model VAR. Penentuan lag 

optimum digunakan untuk menentukan model VAR. Langkah-

langkah dalam melakukan uji lag optimum adalah sebagai 

berikut: 

Blok semua variabel kemudian klik kanan > Open > as VAR  

Maka akan muncul tampilan sebagai berikut: 

 

 

 

 

 

Gambar 3. 7 Tampilan asVAR 

Pada VAR type pilih Unrestricted VAR karena model yang 

akan digunakan adalah model VAR. Kemudian pada 
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Endogenous Variabel tambahkan d( ) karena data stasioner 

pada tingkat difference.  Kemudian klik OK. Maka akan 

muncul output estimasi VAR pada lag yang belum 

dioptimalkan. Setelah itu, langkah untuk mencari lag optimal 

adalah  

Klik View > Lag Structure > Lag Lang Criteria 

 

 

 

 

Gambar 3. 8 Uji Lag Optimum 

Maka akan muncul tampilan sebagai berikut: 

 

 

 

Gambar 3. 9 Lag Specification 
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Pada lags to inculde isikan berapapun lag yang ingin diketahui 

misalkan 2, maka nanti akan muncul output lag yang paling 

optimalkan dengan nilai  AIC terendah atau kode bintang 

terbanyak.  

e. Uji Stabilitas 

 uji ini digunakan untuk mengetahui sudah stabilkah 

model VAR yang digunakan pada lag yang telah dipilih. 

Langkah-langkah dalam melakukan uji stabilitas adalah 

sebagai berikut: 

Pada jendela VAR pilih View > lag structure > AR root table  

 

 

 

Gambar 3. 10 Uji Stabilita 

Maka akan muncul output dari uji stabilitas. 

f. Uji Kointegrasi 

 Uji ini digunakan jika data tidak stasioner pada tingkat 

level namun stasioner pada tingkat first difference. Langkah-
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langkah dalam melakukan uji kointegrasi adalah sebagai 

berikut: 

Blok semua variabel, klik kanan > Open > as Group 

View > Cointegration Test > Johansen Cointegration Test 

 

 

 

 

Gambar 3. 11 Uji Kointegrasi 

Maka akan muncul output uji kointegrasi. 

g. Estimasi VAR 

 Setelah diketahui model VAR yang akan dibentuk maka 

langkah selanjutnya yaitu melakukan estimasi model. 

Langkah-langkah dalam melakukan estimasi model VAR 

adalah sebagai berikut: 

Blok semua variabel > klik kanan > Open > asVAR 

Maka akan muncul tampilan seperti pada gambar berikut: 
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Gambar 3. 12 Estimasi Model VAR 

Pada Lag Interval Endogeonus isikan lag yang sudah optimal. 

Kemudian klik Ok. Maka akan muncul output dari estimasi 

VAR yang sudah optimal. 

h. Uji Kelayakan Model 

 Uji kelayakan model menggunakan uji asumsi klasik.  

Langkah-langkah dalam melakukan uji kelayakan model 

dalam eviews adalah sebagai berikut: 

View > Residual test > Normality Test  

Untuk mengetahui data normal atau tidak. 

View > Residual test > Portmanteau Autocorrelation 

untuk mengetahu apakah terdapat autokorelasi sisaan pada 

model atau tidak.  

View > Residual Test > White heteroskedasticity  
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Untuk mengetahui apakah model mempunyai ragam sisaan 

yang homogen atau tidak. 

View > Residual test > correlogram  

Untuk mengetahui apakah model sudah white noise atau 

belum. 

i. Peramalan  

 Setelah semua uji terpenuhi dan diperoleh model VAR, 

maka langkah selanjutnya adalah melakukan peramalan. 

Langkah-langkah peramalan dalam model VAR dengan 

menggunakan eviews adalah sebagai berikut: 

Pilih Proc > forecast 

 

 

 

 

 

Gambar 3. 13 Forcasting 

Maka akan muncul variabel baru dari hasil peramalannya. 
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Gambar 3. 14 Variabel baru hasil forcasting
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BAB IV 

HASIL DAN PEMBAHASAN 

 

 Pada bab ini berisi analisis dan hasil dari pengolahan 

data time series curah hujan pada 7 (tujuh) stasiun post hujan 

dengan metode VAR (Vector Autoregressive) pada tahun 

2019-2020 dengan periode bulanan. Berikut data stasiun post 

hujan Kabupaten Kudus tahun 2019-2020: 

Tabel 4. 1 Data Curah Hujan tahun 2019-2020 

Bulan 

ke- 

SPH 

Besito Cendono Colo Jekulo 
Karang 

gayam 

Kedung 

gupit 
Kota 

1 473 687 939 568 849 621 499 

2 156 147 201 238 157 243 255 

3 197 360 282 512 304 256 278 

4 74 245 268 224 164 179 210 

5 73 118 99 76 105 90 72 

6 0 12 0 2 0 0 0 

7 0 0 6 2 0 0 0 

8 3 10 27 4 7 0 0 

9 0 0 0 5 0 0 0 

10 3 18 0 0 13 31 10 

11 155 115 167 116 201 121 132 
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12 105 145 141 271 172 156 145 

13 383 652 1103 326 600 472 381 

14 415 772 1065 413 753 450 417 

15 147 211 273 138 139 186 340 

16 154 121 284 295 238 191 170 

17 41 170 181 98 88 76 59 

18 19 26 85 21 0 2 6 

19 20 46 80 98 49 48 65 

20 3 10 21 21 12 9 14 

21 61 51 65 40 79 122 67 

22 163 127 181 128 121 243 270 

23 208 210 281 315 214 335 340 

24 491 762 820 529 836 630 636 

 

A. Hasil  

1. Uji Stasioner Data 

Uji Stasioneritas data merupakan syarat utama 

dalam melakukan pembentukan model menggunakan VAR 

(Vector Autoregressive).  Uji stasioner ini menggunakan uji 

akar-akar unit  (unit root test) dengan metode Augmented 

Dickey Fuller Test (ADF Test). Jika nilai t-ADF lebih kecil 

daripada nilai kritis MacKinnon maka dapat disimpulkan 

data yang digunakan tidak mengandung akar unit. Berikut 
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adalah output dari hasil uji akar unit dari 7(tujuh) variabel 

yang digunakan:  

a.) Uji Akar Unit Variabel Stasiun Post Hujan Besito  

Uji kestasioneran data dilakukan dengan uji akar 

unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 2 uji akar unit SPH Besito tingkat level 

 

Pada tabel 4.1 nilai 𝑝 − 𝑣𝑎𝑙𝑢𝑒 > 0,05 yaitu 

sebesar   0,1303. Dalam uji ADF tolak 𝐻0 jika nilai   

𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼, sehingga dapat disimpulkan bahwa data 

tidak stasioner. Maka dari itu data harus didifference 

agar data stasioner.  

Tabel 4. 3 uji akar unit SPH Besito tingkat first different 
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Pada tabel 4.2 nilai 𝛼 < 0,05 yaitu sebesar   0,001 

sehingga data sudah stasioner pada tingkat difference.  

b.) Uji Akar Unit Variabel Stasiun Post Hujan Cendono 

Uji kestasioneran data dilakukan dengan uji 

akar unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 4 uji akar unit SPH Cendono tingkat level 

 

Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,0853. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 

dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  
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Tabel 4. 5 uji akar unit SPH Cendono tingkat first different 

 

Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   0,0023 

sehingga data sudah stasioner pada tingkat difference.  

c.) Uji Akar Unit Variabel Stasiun Post Hujan Colo 

Uji kestasioneran data dilakukan dengan uji 

akar unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 6 uji akar unit SPH Colo tingkat level 

 

Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,0509. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 
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dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  

Tabel 4. 7 uji akar unit SPH Colo tingkat first different 

 

Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   

0,0012 sehingga data sudah stasioner pada tingkat 

difference.  

d.) Uji Akar Unit Variabel Stasiun Post Hujan Jekulo 

Uji kestasioneran data dilakukan dengan uji 

akar unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 8 uji akar unit SPH Jekulo tingkat level 
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Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,0942. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 

dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  

Tabel 4. 9 uji akar unit SPH Jekulo tingkat first different 

 

Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   

0,0001 sehingga data sudah stasioner pada tingkat 

difference.  

e.) Uji Akar Unit pada Variabel Stasiun Post Hujan 

Karanggayam 

Uji kestasioneran data dilakukan dengan uji akar 

unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 10 uji akar unit SPH Karanggayam tingkat 
level 
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Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,0316. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 

dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  

Tabel 4. 11 uji akar unit SPH Karanggayam tingkat first 
different 

 

Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   

0,0004 sehingga data sudah stasioner pada tingkat 

difference.  

f.) Uji Akar Unit pada Variabel Stasiun Post Hujan 

Kedunggupit 
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Uji kestasioneran data dilakukan dengan uji akar 

unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 12 uji akar unit SPH Kedunggupit tingkat level 

 

Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,2185. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 

dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  

Tabel 4. 13 uji akar unit SPH Jekulo tingkat first 

different 
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Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   

0,0063 sehingga data sudah stasioner pada tingkat 

difference.  

g.) Uji Akar Unit pada Variabel Stasiun Post Hujan Kota 

Uji kestasioneran data dilakukan dengan uji 

akar unit ADF dengan hipotesis: 

𝐻0 : data tidak stasioner 

𝐻1 : data stasioner 

Tabel 4. 14 uji akar unit SPH Kota tingkat level 

 

Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,2111. Dalam uji ADF daerah kritik dari pengujian 

adalah tolak 𝐻0 jika nilai   𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼,  sehingga 

dapat disimpulkan bahwa data tidak stasioner. Maka 

dari itu data harus didifference agar data stasioner.  
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Tabel 4. 15 uji akar unit SPH Kota first different 

 

Pada tabel di atas nilai 𝛼 > 0,05 yaitu sebesar   

0,0675 sehingga data belum stasioner pada tingkat first 

difference. Maka dari itu data harus didiffrence lagi agar 

stasioner. 

Tabel 4. 16 uji akar unit SPH Kota tingkat two different 

 

Pada tabel di atas nilai 𝛼 < 0,05 yaitu sebesar   

0,000 sehingga data sudah stasioner pada tingkat two 

difference. 

Ringkasan Uji Akar Unit Stasiun Post Hujan 

Kabupaten Kudus: 

 



62 
 

 
 

 

Tabel 4. 17 ringkasan hasil uji akar unit SPH Kabupaten 
Kudus 

Variabel Nilai Probabilitas Ket 

Level Diff(1) Diff(2)  

Stasiun Besito 0,1303 0,001 - Stasioner 

Stasiun Cendono 0,0853 0,0023 - Stasioner 

Stasiun Colo 0,0509 0,0012 - Stasioner 

Stasiun Jekulo 0,0942 0,0001 - Stasioner 

Stasiun Karanggayam 0,0316 0,0004 - Stasioner 

Stasiun Kedunggupit 0,2185 0,0063 - Stasioner 

Stasiun Kota 0,2111 0,0675 0,000 Stasioner 

Pada tabel di atas menunjukkan semua data 

variabel dalam penelitian adalah stasioner pada tingkat 

difference. Selanjutnya dilakukan uji Kausalitas Granger 

untuk mengetahui variabel mana yang saling 

mempengaruhi. 

2. Kausalitas Granger 

Uji ini dilakukan untuk mengetahui sebab akibat dari 

masing-masing variabel endogen dalam sistem. Pada uji ini 

terdapat tiga kemungkinan, yaitu terdapat satu hubungan 

antara variabel satu dengan yang lainnya yaitu one way 

kausality, terdapat dua hubungan antara variabel satu 

dengan variabel yang lainnya yaitu saling mempengaruhi 
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satu sama lain (two ways kausality) dan tidak terdapat 

hubungan antara kedua variabel. Output uji Granger 

Kausality di tunjukkan pada tabel 4.17 dengan hipotesis: 

𝐻0 : tidak terdapat pengaruh antara variabel X dengan 

variabel Y 

𝐻1 : terdapat pengaruh antara variabel X dengan variabel  
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Tabel 4. 18 uji Kausalitas Granger 
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Pengambilan keputusan pada uji Granger Kausality 

berdasarkan nilai probabilitas. Jika 𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 0,05 maka 

𝐻0 ditolak, artinya terdapat pengaruh antara variabel X 

dengan variabel Y. Berikut adalah ringkasan variabel yang 

memiliki 𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 0,05 :  

Tabel 4. 19 ringkasan uji Kausalitas Granger 

X Y Hubungan 

SPH Colo SPH 

Kedunggupit 

One way 

SPH 

Kedunggupit 

SPH Besito One way 

SPH Kota SPH Jekulo One way 

SPH Kota SPH 

Karanggayam 

One way 

SPH 

Karanggayam 

SPH Besito Two Ways 

SPH Besito SPH 

Karanggayam 

Two Ways 

SPH 

Kedunggupit 

SPH Cendono Two Ways 

SPH Cendono SPH 

Kedunggupit 

Two Ways 

SPH SPH Two Ways 



67 
 

 
 

Kedunggupit Karanggayam 

SPH 

Karanggayam 

SPH 

Kedunggupit 

Two Ways 

Keterangan : 

X = variabel yang mempengaruhi 

Y = variabel yang dipengaruhi 

SPH = Stasiun Post Hujan 

 Ringkasan tersebut menjelaskan hubungan antar 

variabel yang diuji. Variabel-variabel yang mempunyai 

hubungan satu arah (one way kausality) adalah antara 

variabel SPH Colo dengan SPH Kedunggupit, SPH 

Kedunggupit dengan SPH Besito, SPH Kota dengan SPH 

Jekulo, dan SPH Kota dengan SPH Karanggayam. 

Kemudian, variabel-variabel yang mempunyai 

hubungan dua arah (two ways kausality) yaitu dimana 

varibel satu mempengaruhi variabel lainnya dan 

sebaliknya adalah antara SPH Karanggayam dengan 

SPH Besito dan sebaliknya, SPH Kedunggupit dengan 

SPH Cendono dan sebaliknya, dan SPH Kedunggupit 

dengan SPH Karanggayam juga sebaliknya. Sedangkan 

variabel-variabel yang tidak mempengaruhi satu sama 

lain diantaranya SPH Cendono terhadap SPH Besito dan 

sebaliknya, SPH Colo terhadap SPH Besito dan 

sebaliknya, SPH Jekulo terhadap SPH Besito dan 
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sebaliknya, SPH Kota terhadap SPH Besito dan 

sebaliknya, SPH Colo terhadap SPH Cendono dan 

sebaliknya, SPH Jekulo terhadap SPH Cendono dan 

sebaliknya, SPH Kota terhadap SPH Colo dan 

sebaliknya, SPH Karanggayam terhadap SPH Jekulo dan 

sebaliknya, SPH Kota terhadap SPH Kedunggupit dan 

sebaliknya.  

3. Uji Lag Optimum 

Penentuan panjang lag optimum bertujuan untuk 

menentukan model VAR. Pemilihan lag optimum 

didasarkan pada nilai terkecil dari standar Akaike 

Information Criterion (AIC). Pengujian lag optimum 

disajikan dalam tabel sebagai berikut: 

Tabel 4. 20 uji Lag Optimum 

 

Berdasarkan tabel 4.19 nilai Akaike Information 

Criterion (AIC) terdapat pada lag 1 yaitu sebesar 75,76645. 

Jadi model yang digunakan adalah VAR(1). Sehingga semua 
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variabel dalam model saling mempengaruhi tidak hanya 

pada periode saat ini, namun pada satu periode 

sebelumnya.  

4. Uji Stabilitas  

Uji stabilitas dilakukan untuk mengetahui apakah 

model VAR stabil pada lag 1 atau tidak, karena pada 

pemilihan lag optimum diperoleh lag 1. Untuk menguji 

kestabilan VAR menggunakan Roots of Characteristic 

Polynomial. Suatu sistem VAR dikatan stabil apabila 

seluruh roots nya memiliki modulus lebih kecil dari satu. 

Output uji stabilitas ditunjukkan pada tabel berikut :  

Tabel 4. 21 uji Stabilitas 
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Pada tabel 4.20 menunjukkan bahwa sistem VAR 

sudah stabil pada lag 1. Hal ini ditunjukkan pada nilai 

modulus yang kurang dari 1. Selain dalam tabel juga dapat 

dilihat dari grafik lingkaran berikut: 

 

 

 

 

   

 

 

 

Grafik 4. 1 Grafik uji stabilitas 

Grafik di atas menunjukkan titik-titik berada di 

dalam lingkaran. Maka artinya model VAR sudah stabil. 

5. Uji Kointegrasi 

Uji Kointegrasi dilakukan jika data tidak stasioner 

pada tingkat level. Pada pengujian stasioneritas 

menunjukkan bahwa data stasioner pada tingkat first 

different, maka dari itu harus dilakukan uji kointegrasi. Uji 

ini digunakan untuk mengetahui adakah kesetimbangan 

pada jangka panjang yaitu terdapat kesamaan pergerakan 

dan stabilitas hubungan antara variabel-variabel dalam 

penelitian atau tidak. Uji ini menggunakan uji Johansen’s 
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Cointegration Test. Hipotesis nol nya adalah jika nilai trace 

statistic dan nilai maximum eigenvalue lebih besar dari 

nilai critical value pada tingkat signifikansi 0,05 maka tidak 

terdapat kointegrasi antar variabel pada penelitian. 

Berikut adalah tabel dari uji Johansen’s Cointegrastin Test: 

Tabel 4. 22 uji Kointegrasi 

 

 

Tabel 4.21 menunjukkan bahwa nilai trace dan 

maximum eigenvalue lebih besar dari nilai critical value pada 

tingkat signifikansi 5% atau dapat dilihat dari banyaknya 
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bintang yang terdapat pada AT Most dimana hanya ada dua 

bintang pada at most variabel. Hal ini berarti tidak terdapat 

kointegrasi antara variabel-variabel dalam sistem.  Maka dari 

model yang digunakan adalah model VAR dalam level. 

6. Estimasi VAR  

Model VAR dalam level terbentuk karena data 

stasioner pada tingkat different. Berikut adalah estimasi 

model VAR(1) : 

Tabel 4. 23 Estimasi Nilai VAR 
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Tabel 4.22 menunjukkan pendugaan parameter dan 

nilai t. Pada baris pertama adalah nilai pendugaan 

parameter, dan di dalam [ ] adalah nilai t. Berdasarkan 

output dari estimasi model VAR(1), maka diperoleh 

persamaan VAR(1) sebagai berikut: 

𝑑(𝑏𝑒𝑠𝑖𝑡𝑜) = −0,439𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,287𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

− 0,029𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,241𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,258𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 2,469𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1 − 0,651𝑑(𝑘𝑜𝑡𝑎)𝑡−1

+ 8,835 
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𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)

= 0,555𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1

− 0,036𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,745𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 1,4𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 3,059𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 3,187𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 1,735𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 12,854 

𝑑(𝑐𝑜𝑙𝑜) = −0,227𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,763𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,25𝑑(𝑐𝑜𝑙𝑜)𝑡−1

+ 0,1,644𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 3,893𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 5,289𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 2,294𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 8,171 

𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)

= 2,05𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1

− 0,046𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,148𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,23𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 2,066𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 1,167𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,176𝑑(𝑘𝑜𝑡𝑎)𝑡−1 − 1,709 
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𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)

= 0,144𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1

+ 0,112𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,582𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,997𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 2,959𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 3,3905𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 1,1704𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 14,109 

𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)

= 0,151𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1

+ 0,248𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,1009𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,451𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,389𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 2,204𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,617𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 11,071 

𝑑(𝑘𝑜𝑡𝑎) = 0,522𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,569𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

− 0,2783𝑑(𝑐𝑜𝑙𝑜)𝑡−1

+ 0,304𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,191𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 1,869𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,757𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 15,563 

7. Uji Kelayakan Model 

Model VAR merupakan model yang mengikuti model 

OLS (Ordinary Least SquareI). Maka dari itu perlu 
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dilakukan uji Asumsi Klasik. Berikut adalah uji Asumsi 

Klasik dari model VAR yang terbentuk: 

a.) Uji Normalitas 

 

Grafik 4. 2 Uji Normalitas 

𝐻0 : data tidak berdistribusi normal 

𝐻1 : data berdistribusi normal 

Pengambilan keputusan uji normalitas jika 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 > 𝛼 maka 𝐻0 ditolak. Grafik 4.1 

menunjukkan nilai probabilitas dari uji normalitas 

model tersebut sebesar 0,662631 yaitu lebih besar 

dari 𝛼 0,05 maka 𝐻0 ditolak. Maka artinya data 

berdistribusi normal. 

b.) Uji Linieritas 

Tabel 4. 24 Uji Linieritas 
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Tabel 4.23 menunjukkan nilai probabilitas 

sebesar 0,0153 yaitu kurang dari 0,05 artinya 

variabel-variabel yang digunakan sudah linier. 

 

 

c.) Uji Multikolinieritas 

Tabel 4. 25 Uji Multikolinieritas 
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Pengujian multikolinieritas di atas 

menunjukkan nilai VIF >10 maka artinya terdapat 

multikolinieritas antara variabel-variabel yang 

digunakan. Hal ini artinya terdapat korelasi yang 

tinggi antar variabel-variabel yang digunakan.  

d.) Uji Heteroskedasitas 

Tabel 4. 26 Uji Heteroskedasitas 

 

Pengujian heteroskedisitas ini dilihat dari nilai 

obs’R-square. Jika nila probabilitasnya lebih dari 

0,05 atau 5% maka artinya model yang terbentuk 

bebas dari heteroskedasitas. Pada tabel tersebut 

nilai Obs’Rsquare sebesar 0,7641 maka model yang 

terbentuk bebas dari heteroskedasitas. 

e.) Uji Autokorelasi 

Tabel 4. 27 Uji Autokorelasi 

 

𝐻0 : Terdapat Autokorelasi 

𝐻1 : Tidak terdapat Autokorelasi 
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Uji autokorelasi dilihat dari nilai 

probabilitasnya. Jika  𝑝 − 𝑣𝑎𝑙𝑢𝑒 > 𝛼 maka 𝐻0 

ditolak. Pada tabel 4.26 terlihat nilai probabilitas 

lebih dari  𝛼=0,05 yaitu sebesar 0,8359 maka dapat 

disimpulkan bahwa model yang terbentuka telah 

lolos dari autokorelasi.   

Tahap pengujian analisis klasik sudah terpenuhi 

maka dapat disimpulkan bahwa model VAR sudah valid.  

8.  Peramalan  

Berdasarkan model VAR(1) hasil peramalan curah 

hujan Kabupaten Kudus ke tujuh stasiun hujan tahun 2021 

adalah sebagai berikut: 

 

 

 



 

80 
 

Tabel 4. 28 Hasil Peramalan 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bulan Besito Cendono Colo Jekulo Karanggayam Kedunggupit Kota 

1 536,5 549,5 660,9 599,7 738,3 742,8 781,6 

2 560 569,3 687 620,8 769,1 774,4 816 

3 584 590,3 714,6 642,4 800,9 806,6 850,6 

4 608 611,7 742,7 663,7 832,8 838,8 885,6 

5 631 632,2 769,7 685 864,2 870,7 920,3 

6 655 652,9 796,8 706,3 895,6 902,6 954,9 

7 679 674 824,5 727,7 927,4 934,8 989,7 

8 703 694,8 851,9 749 959 966,8 1024,4 

9 727,4 715,5 879,1 770,3 990,5 998,8 1059 

10 751,33 736,4 906,5 791,7 1022,12 1030,8 1093,8 

11 775,24 757,3 934 813 1053,7 1062,9 1128,6 

12 799,13 778,1 961,3 834,3 1085,3 1094,9 1163,3 
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Keterangan: 

0-300 = kategori rendah 

300-700 = kategori sedang 

700> = kategori tinggi 

Satuan Curah Hujan = milimeter (mm) 

Hasil peramalan pada tahun 2021 dari stasiun post 

hujan  Kabupaten Kudus rata-rata dalam kategori sedang.  

Sedangkan curah hujan dalam kategori tinggi terjadi pada 

bulan  Agustus sampai Desember.  Daerah yang memiliki 

curah hujan kategori tinggi di Kabupaten Kudus adalah post 

hujan Karanggayam, Kedunggupit, dan Kota. Berikut adalah 

grafik yang menunjukkan perbandingan data tahun 2019-

2020 dengan hasil peramalan tahun 2021: 

Grafik 4. 3 Grafik Curah Hujan Stasiun Post Hujan Kabupaten 
Kudus Tahun 2019 
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Grafik 4. 4 Grafik Curah Hujan Stasiun Post Hujan Kabupaten 
Kudus Tahun 2020 

 

Grafik 4. 5 Hasil Peramalan Curah Hujan Stasiun-stasiun Post 
Hujan Kabupaten Kudus 
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BAB V 

KESIMPULAN DAN SARAN 

A. Kesimpulan 

Berdasarkan hasil analisis data yang telah dilakukan, 

maka disimpulkan SPH Kudus tahun 2019-2020 optimal pada 

lag-1 sehingga model VAR yang terbentuk adalah VAR(1). 

Artinya variabel-variabel yang digunakan dalam model saling 

berpengaruh tidak hanya pada periode 2021, namun juga 

pada satu periode sebelumnya.  

Hasil peramalan pada tahun 2021 dari stasiun post 

hujan  Kabupaten Kudus rata-rata dalam kategori sedang dan   

pada kategori tingg pada bulan  Agustus sampai Desember.  

Sedangkan daerah yang memiliki curah hujan tinggi di 

Kabupaten Kudus adalah post hujan Karanggayam, 

Kedunggupit, dan Kota. 
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B. Saran 

Peramalan sekripsi ini menggunakan data bulanan 

selama 2 tahun yaitu sebanyak 24 periode dan hasil 

peramalannya selama 12 periode. Untuk penelitian 

selanjutnya dapat menggunakan data dengan rentang waktu 

yang lebih panjang agar dapat memperoleh hasil yang lebih 

akurat. Selain itu, penelitian ini hanya menggunakan metode 

VAR biasa, bagi peneliti selanjutnya dapat menggunakan 

metode VARX atau VARMAX jika ingin mengembangkan topik 

dan metode yang lebih kompleks. 
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LAMPIRAN 

Lampiran  1 : Data Curah Hujan Stasiun Post Hujan Kabupaten 
Kudus 

Bulan 

ke- 

SPH 

Besito Cendono Colo Jekulo 
Karang 

gayam 

Kedung 

gupit 
Kota 

1 473 687 939 568 849 621 499 

2 156 147 201 238 157 243 255 

3 197 360 282 512 304 256 278 

4 74 245 268 224 164 179 210 

5 73 118 99 76 105 90 72 

6 0 12 0 2 0 0 0 

7 0 0 6 2 0 0 0 

8 3 10 27 4 7 0 0 

9 0 0 0 5 0 0 0 

10 3 18 0 0 13 31 10 

11 155 115 167 116 201 121 132 

12 105 145 141 271 172 156 145 

13 383 652 1103 326 600 472 381 

14 415 772 1065 413 753 450 417 

15 147 211 273 138 139 186 340 

16 154 121 284 295 238 191 170 

17 41 170 181 98 88 76 59 
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18 19 26 85 21 0 2 6 

19 20 46 80 98 49 48 65 

20 3 10 21 21 12 9 14 

21 61 51 65 40 79 122 67 

22 163 127 181 128 121 243 270 

23 208 210 281 315 214 335 340 

24 491 762 820 529 836 630 636 

  

Lampiran  2: Uji Stasioner Variabel SPH Besito Tingkat Level 

 

Lampiran  3: Uji Stasioner Variabel SPH Besito Tingkat First 
Different  
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Lampiran  4: Uji Stasioner Variabel SPH Cendono Tingkat 
Level  

 

Lampiran  5: Uji Stasioner Variabel SPH Cendono Tingkat First 
Different 

 

Lampiran  6: Uji Stasioner Variabel SPH Colo Tingkat Level
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Lampiran  7: Uji Stasioner Variabel SPH Colo Tingkat First 
Different 

 

Lampiran  8: Uji Stasioner Variabel SPH Jekulo Tingkat Level

 

Lampiran  9 : Uji Stasioner Variabel SPH Jekulo Tingkat First 
Different 
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Lampiran  10: Uji Stasioner Variabel SPH Karanggayam 
Tingkat Level 

 

Lampiran  11: Uji Stasioner Variabel SPH Karanggayam 
Tingkat First Different 
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Lampiran  12: Uji Stasioner Variabel SPH Kedunggupit 
Tingkat Level 

 

Lampiran  13: Uji Stasioner Variabel SPH Kedunggupit 
Tingkat First Different 

 

Lampiran  14: Uji Stasioner Variabel SPH Kota Tingkat Level
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Lampiran  15: Uji Stasioner Variabel SPH Kota Tingkat First 
Different 

 

Lampiran  16: Uji Stasioner Variabel SPH Kota Tingkat Two 
Different 
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Lampiran  17: Uji Kausalitas Granger 
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Lampiran  18: Uji Lag Optimum 

 

Lampiran  19: Uji Stabilitas 
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Lampiran  20: Uji Kointegrasi 
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Lampiran  21: Estimasi Nilai VAR 
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Lampiran  22: Persamaan VAR(1) 

(𝑏𝑒𝑠𝑖𝑡𝑜) = −0,439𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,287𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

− 0,029𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,241𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,258𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 2,469𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,651𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 8,835 

𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜) = 0,555𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 − 0,036𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,745𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 1,4𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 3,059𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 3,187𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 1,735𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 12,854 
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𝑑(𝑐𝑜𝑙𝑜) = −0,227𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,763𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,25𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,1,644𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 3,893𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 5,289𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 2,294𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 8,171 

𝑑(𝑗𝑒𝑘𝑢𝑙𝑜) = 2,05𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 − 0,046𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,148𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,23𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 2,066𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 1,167𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,176𝑑(𝑘𝑜𝑡𝑎)𝑡−1 − 1,709 

𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)

= 0,144𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,112𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,582𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,997𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 2,959𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 3,3905𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 1,1704𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 14,109 

𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)

= 0,151𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,248𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

+ 0,1009𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,451𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,389𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 2,204𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,617𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 11,071 
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𝑑(𝑘𝑜𝑡𝑎) = 0,522𝑑(𝑏𝑒𝑠𝑖𝑡𝑜)𝑡−1 + 0,569𝑑(𝑐𝑒𝑛𝑑𝑜𝑛𝑜)𝑡−1

− 0,2783𝑑(𝑐𝑜𝑙𝑜)𝑡−1 + 0,304𝑑(𝑗𝑒𝑘𝑢𝑙𝑜)𝑡−1

− 1,191𝑑(𝑘𝑎𝑟𝑎𝑛𝑔𝑔𝑎𝑦𝑎𝑚)𝑡−1

+ 1,869𝑑(𝑘𝑒𝑑𝑢𝑛𝑔𝑔𝑢𝑝𝑖𝑡)𝑡−1

− 0,757𝑑(𝑘𝑜𝑡𝑎)𝑡−1 + 15,5
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Lampiran  23 :Hasil Peramalan 

 

 

 

 

 

 

 

 

Bulan Besito Cendono Colo Jekulo Karanggayam Kedunggupit Kota 

1 536,5 549,5 660,9 599,7 738,3 742,8 781,6 

2 560 569,3 687 620,8 769,1 774,4 816 

3 584 590,3 714,6 642,4 800,9 806,6 850,6 

4 608 611,7 742,7 663,7 832,8 838,8 885,6 

5 631 632,2 769,7 685 864,2 870,7 920,3 

6 655 652,9 796,8 706,3 895,6 902,6 954,9 

7 679 674 824,5 727,7 927,4 934,8 989,7 

8 703 694,8 851,9 749 959 966,8 1024,4 

9 727,4 715,5 879,1 770,3 990,5 998,8 1059 

10 751,33 736,4 906,5 791,7 1022,12 1030,8 1093,8 

11 775,24 757,3 934 813 1053,7 1062,9 1128,6 

12 799,13 778,1 961,3 834,3 1085,3 1094,9 1163,3 
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